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New and expanded Features Make unitedstreaming 
Your Primary Source for Digital Media Content

•	Dynamic, drill-down navigation menu drives targeted searches

•	New navigation tools provide path or “breadcrumb” links

•	Teacher tools support creation of teacher-selected content 
for student access

•	Teacher preferences allow you to create a customized 
homepage to display links to curriculum tools, new videos, 
calendar events and teaching tips

•	New media types including audio files and animations support 
different learning styles and add depth to your projects

•	Professional Development content provides tools for 
technology integration and supports teachers’ professional 
growth and development

Use unitedstreaming’s New Teacher Tools to Create 
and Innovate in Your Classroom

•	Assignment Builder 
Gather video segments, images, quizzes and trusted 
websites in one place and create an interactive learning 
experience for students.

•	Quiz Builder 
Assess student comprehension or survey prior knowledge 
with a unitedstreaming quiz. Search the Quiz Library, choose 
individual questions from the Quiz Builder databank or write 
your own questions.

•	Writing Prompt Builder 
Stimulate the writing process in your classroom with images 
that are ready-made for declarative, persuasive, narrative, 
and expository writing exercises.

Professional Development

Discovery Education provides state-of-the art professional 
development that offers differentiated instructional 
approaches. With the next generation of unitedstreaming, 
we’ve got you and your staff covered.

•	Interactive Training 
These self-directed modules offer certificate and 
professional development credit options. A variety of lessons 
demonstrate best practices for integration of digital media in 
the classroom and the web-based, hands-on format supports 
individual pace and style of learning. 

•	Webinars 
A webinar is an online seminar with interactive training 
elements. Collaborate in live, hour-long sessions with a 
unitedstreaming instructor using Webex™ and your phone 
line. Registration is fast and easy online at: 
www.unitedstreaming.com

•	Digital Connections	
Expanding on the webinar format, you can arrange a half-
day staff development session to include both live, online 
instruction with a hands-on workshop. Contact your Account 
Representative at 1-800-323-9084 today to schedule a session.

•	Courses for Graduate Credit 
Graduate courses focus on integrating digital media into 
the curriculum and are available to unitedstreaming users. 
Course credit can be transferred, applied to certificate 
programs, or used as the beginning of a masters program.

Discovery Education unitedstreaming

INTRODUCTION

Engage Your Students with Digital Media Content
Discovery Education unitedstreaming is the only digital video-based learning resource scientifically 
proven to increase academic achievement. Featuring more than 5,000 full-length videos divided into 
50,000 content-specific video segments, unitedstreaming enables you to seamlessly integrate digital 
media in the classroom.   

This User Guide provides an overview of unitedstreaming. Our enhanced interface puts more 
information, search tools and navigation links at your fingertips.

http://www.unitedstreaming.com
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Existing Users

Enter your username and password in the “LOG IN” section on 
the right side of the screen and click “GO.”

New Users

1.	Go to www.unitedstreaming.com

2.	Enter your eight-character school passcode in the 
“NEW USER?” section on the right side of the screen and
click “GO.”

•	 A passcode allows new users to create and register a 
personal username and password for access  
to unitedstreaming.

•	 You must obtain your school passcode to create an 
account. Thereafter, you no longer need the passcode.

•	 If you do not have a passcode, please contact your 
unitedstreaming Account Representative, or call 
Discovery Education at 1-800-323-9084.

3.	Once you enter the passcode, you will be prompted to 
create your account.

a.	Fill in the required fields, which are indicated by an 
asterisk. You must also check the box to agree to the 
Terms of Use.

b.	Your username must be a minimum of six characters long. 
Both the username and password may contain these 
characters only: letters, numbers, hyphen, and period.

c.	Subscribe to the newsletter to receive monthly updates 
about featured videos, new tools, and integration ideas.

4.	Your confirmation will be e-mailed to you. 

Discovery Education unitedstreaming

GETTING STARTED

Accessing Discovery Education unitedstreaming

Integration Ideas: Look for these throughout your User Guide. 
Learn about unitedstreaming at your own pace by logging into Interactive Training.

NOTES:

http://www.unitedstreaming.com
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Make sure to check the box “Use My Home Page as my default 
home page for unitedstreaming” and your customized home 
page will be displayed each time you log in to the site.

My Homepage
You can now design a customized Discovery Education unitedstreaming homepage to view new 
content updates and weekly teacher tips. Simply click on the “Preferences” link in the navigation bar 
at the top of the screen and select the “My Home Page” tab. You control the content you wish to view. 
Select calendar listings and featured videos, receive updates as new videos are added to the site, 
learn which videos receive the most views and draw inspiration from regular teaching tips.

Discovery Education unitedstreaming

GETTING STARTED

NOTES:

http://www.unitedstreaming.com
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Keyword Search

Use the Keyword Search to conduct targeted searches for 
specific media types such as: video segments, images, articles 
and clip art. The search results will return video titles and 
descriptions that contain the keyword you entered. The power 
of Boolean Query allows you to include and exclude words or 
phrases—for example: revolution NOT industrial. If you use 
quotation marks to search for a phrase—for example, “magic 
school bus”—you will constrain your search to media that 
includes the entire phrase in the title or description.

Advanced Search

The Advanced Search keyword option supports more 
powerful searching capabilities that allow you to focus on a 
specific media publisher or limit your search to include only 
Editable, Closed Captioned, Spanish or New Titles. You can 
also choose to exclude Spanish or Classic1 titles from your 
search results. Click on “Explore All Titles” to browse the entire 
video collection and select subject areas of interest to you.

Subject Search

Click on one of eight core 
subject areas to view a 
complete listing of media 
resources that match the 
subjects that you teach. 
You can refine your subject 
search by choosing a grade 
range or a more  
specific subject.

Grade Search

Select a grade range to 
view a complete listing of 
unitedstreaming content 
appropriate for your 
students. If you wish to filter 
your search results more 
precisely, you can choose 
from eight different core 
subjects or select from up to 
nine different media types.

Curriculum Standards

Videos in the 
unitedstreaming library 
have been cross-referenced 
to teaching standards for 
all states. Use this tool to 
quickly locate videos and 
images that match your state curriculum standards. The state 
field is pre-populated to reflect your school location. Select 
the subject area and grade level and click “go.” Then find the 
standard you are interested in and look for links to videos 
meeting the standard.
1	 Classic titles are programs that date from the 1970s and 80s. Some teachers 

feel that the subject matter and content is still valuable.

Search Tools
Robust search tools and dynamic browsing capability enable you to quickly locate a variety of media 
assets and refine your search results by subject, grade or media type.  As you conduct and refine a 
search, you can move forward and backward in your search results by clicking on any of the links in 
the breadcrumb trail.

Discovery Education unitedstreaming

GETTING STARTED

Integration Idea:  
Incorporate editable video segments and audio files in your digital storytelling projects.
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A keyword search for All Content returns a listing of full videos 
in the main results area. You can now modify the number of 
resources displayed on the page by clicking on the dropdown 
menu to display 10, 25, 50 or 100 items per page. Each video 
title appears in blue, with the total run time displayed at the 
end of the title. Also included are a brief video description, 
the grade range and publisher, and links to Blackline Masters, 
Teachers Guides (when available), and state curriculum 
standards. Icons will indicate Spanish, Closed-Captioned and 
Editable titles.

Click on either the video title or the thumbnail image to access 
the full video description page.

Links to nine different media types are displayed in the left 
side navigation bar. In this example, a keyword search for all 
content using the word “constitution” yielded 48 full videos 
and 224 video segments. The search also located 133 images, 
763 articles, 8 quizzes, 37 events, and 4 lesson plans. To access 
a resource type, click on the appropriate link.

Exploring Your Search Results
The search feature offers users powerful tools to look for videos, video segments, and additional 
resources that match search terms. You can narrow your keyword search by media type, by making 
your selection from the “WITHIN” drop down menu. 

Discovery Education unitedstreaming

GETTING STARTED

http://www.unitedstreaming.com
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Playing & Downloading Videos

You can use the flexible features on the full video page to play 
and download videos, save them to a folder in My Content or 
e-mail a friend. Easy to use content tabs provide quick access 
to video segments, citation information and related materials.

Exploring the Full Video Page

Discovery Education unitedstreaming

GETTING STARTED

Integration Idea:  
Take students on a virtual field trip with Google Earth and insert hyperlinks to relevant unitedstreaming video segments.
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Exploring the Full Video Page—New Features & Tools

Print Video Information

Generate pages that include video information and are printer 
friendly by clicking on the link labeled “Printer Friendly.”

E-mail a Friend

You can send page links by e-mail to other unitedstreaming 
users by clicking on the link labeled “E-mail a Friend.” Simply 
type your colleague’s e-mail address in the field provided, type 
a personal message and click the “Send E-mail” button.

Add to

With the “Add to” feature, you can add selected video 
segments to folders in “My Content,” quizzes or assignments.

1.	Check the box next to the video segment you wish to add.

2.	Scroll to the bottom of the screen and make your selection 
from the “Add to” menu.

3.	Click the “ADD” button. 

Rate the Video

Share your opinion of the video with the unitedstreaming 
community. Choose your video rating from the “Rate” menu.

Discovery Education unitedstreaming

GETTING STARTED

http://www.unitedstreaming.com
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Play a Video

You can view a video segment “live” or stream it “real-time” by 
clicking on the Play button. The quality of the video streaming 
experience will depend on many factors including the speed of 
your Internet connection and the number of people at your school 
who are online at the time you choose to stream video content.

Step 1:	 Choose your Media Settings:

•	Enable Closed-Captioning (if appropriate)

•	Select Media Type:

›	Windows Media Player for PC

›	QuickTime for Mac

•	Make your Player Selection:

›	Embedded in Web Browser  
(plays right on the page)

›	Stand-Alone Application  
(opens a new player window)

Step 2:	 Click the Play button next to the desired video 
segment to view the video. TIP:	 Make sure you have the latest version of the free Windows Media Player 

(PC) or the Apple QuickTime player (Mac) installed on your computer. You 
will find download links to these applications in the online help section of 
www.unitedstreaming.com.

NOTE:	 Playing/streaming video is recommended for previewing, while 
downloading is recommended for classroom use. Downloading 
insures a smooth and uninterrupted playing experience that will not 
be diminished by bandwidth or connectivity issues. If your school uses 
Network Manager or Blocktime Editor, streaming and downloading may 
be available only during off-peak times. For more information about 
Network Manager or Blocktime Editor, contact your unitedstreaming 
Account Representative or call Discovery Education at 1-800-323-9084.

Playing Full Videos & Video Segments
Discovery Education unitedstreaming videos are divided into “chapters” or “segments” so educators 
can show the parts that best relate to their teaching objective or lesson. Click on the Video Segments 
tab to view a complete list of video segments. 

Discovery Education unitedstreaming

GETTING STARTED

NOTES:

Integration Idea:  
Project video content on an interactive whiteboard and use the pause feature to highlight important information. 

http://www.unitedstreaming.com
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Downloading Full Videos & Video Segments
Download a Video

When you download a video segment, you save a copy of the file on your computer or network for future access.

PC

Step 1:	 Right-click on the Download icon next to the desired 
video segment and select “Save Target As.”

Step 2:	 Navigate to the desired location.

Step 3:	 Save the file.

Mac

Step 1:	 Control-click on the Download icon next to the desired 
video segment and select “Download Linked File.”

Step 2:	 Navigate to the desired location.

Step 3:	 Save the file.

Discovery Education unitedstreaming

GETTING STARTED

NOTES:

http://www.unitedstreaming.com
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Citations
Citation information is provided for videos, video segments, images and articles. Click on the 
Citations tab to view MLA, APA and Chicago Manual of Style formats. Citations may be copied and 
pasted into projects that include Discovery Education unitedstreaming content.

Protecting Discovery Education unitedstreaming Content
All users are bound by current “Terms of Use” found in the footer at www.unitedstreaming.com. If 
you have additional questions regarding “Terms of Use,” contact us at info@unitedstreaming.com. 
Please include your name, institution, position and specific question or issue. 

Discovery Education unitedstreaming

GETTING STARTED

Integration Idea:  
Brainstorm essay ideas using Inspiration and embed video segments to explore additional areas of the topic.

http://www.unitedstreaming.com
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Curriculum Standards

unitedstreaming videos are correlated to state standards 
nationwide. To view a list of standards for your state that relate 
to the video, click on the Curriculum Standards link.

Blackline Masters

Blackline Masters are supplementary materials such as 
worksheets, quizzes, word searches, crossword puzzles and 
other classroom tools that support unitedstreaming video 
content. The PDF format makes it easy to download and print 
these materials.

Teacher’s Guides

Teacher’s Guides contain program objectives, discussion 
questions, and lesson plans that support unitedstreaming 
video content. Many of the Teacher’s Guides also contain 
the full script of the video programs which may be helpful in 
the creation of additional student handouts. The PDF format 
makes it easy to download and print these materials.

Quizzes

Quizzes can be used to test student comprehension 
or survey prior knowledge on a particular subject. Many 
unitedstreaming videos contain pre-made quizzes. Students 
can access quizzes through the Student Center.

Related Materials 
Many Discovery Education unitedstreaming videos provide quick links to Curriculum Standards, 
Blackline Masters, Teachers Guides and Quizzes. Click on the Related Materials tab to access 
these materials. 

Discovery Education unitedstreaming

GETTING STARTED

http://www.unitedstreaming.com
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You now have the ability to add unitedstreaming content to 
folders you create in My Content, by using the “Add to” drop 
down menu on any media resource page. You can create 
sub-folders within main folders to create hierarchies within 
content, grade levels or courses. You can also choose to share 
folder contents with your school and your district.

Adding resources to My Content does not initiate a playing 
or downloading procedure. The purpose of My Content is to 
bookmark the resource to avoid searching for it again. All files 
and projects are stored on the unitedstreaming servers.

My Content
This new feature allows you to collect, organize, share and retrieve your favorite Discovery Education 
unitedstreaming media resources, assignments, quizzes and writing prompts in one convenient 
place. Located in the navigation bar at the top of the screen, “My Content” is accessible from 
anywhere on the site.

Discovery Education unitedstreaming

GETTING STARTED

Integration Idea:  
Develop collaborative, interdisciplinary media projects with your colleagues by sharing your assignments in My Content.
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Add a Media Resource to My Content

1.	Locate a resource that you wish to add to My Content.

2.	Select “My Content” from the “Add to” drop down menu 
and click “ADD.”

NOTE:	 Make sure to allow pop-ups from unitedstreaming when adding 
material to My Content, or hold down the “Control” key when clicking 
the “ADD” button to temporarily allow the pop-up window to open.

3.	A pop-up window will open. You may add the resource to 
the “My Content” default folder, select a folder or add it to a 
new folder.

4.	If you select “Add to New Folder,” follow the prompts and 
enter a folder name and folder location. My Content allows 
you to create folders within folders.

5.	Click on “Add” and the window will display a confirmation 
message, telling you that your content has been added. 

6.	To access your content, click on the “My Content” link on the 
navigation bar at the top of the screen.

Put the flexibility of My Content to work for you. Once you have 
added media resources to My Content, you can use the pull 
down menu to copy, move, share and delete them at any time. 
You can also sort your resources by type, name, creation date, 
subject, or grade. Use the arrows to move resources up or 
down the list, so that they are organized in the way that is most 
useful to you.

Current unitedstreaming users

Are you a unitedstreaming user who created video playlists, 
multimedia assignments or quizzes with an earlier version 
of unitedstreaming? All of the work you created can now be 
found in My Content—just click on the “My  Content” link 
on the navigation bar at the top of the screen to locate your 
favorite digital resources.

My Content 

NOTES:

Discovery Education unitedstreaming

GETTING STARTED

http://www.unitedstreaming.com
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Discovery Education unitedstreaming

Teacher center

Teacher Center
The Teacher Center provides you with powerful tools that allow you to create dynamic, interactive 
multimedia projects for your students. You can save and organize your projects in folders you create 
within My Content for easy editing, sharing and retrieval.

Integration Idea:  
Gather digital resources using the Assignment Builder and create a WebQuest for students.
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Step 1: General Information

Start by providing information about your assignment in the 
form provided. The assignment name, author, school, subject 
area, and grade level are required fields. You can also create 
assignment instructions, learning objectives and teacher notes.

You can save your assignment by clicking on the “Save” button 
at the bottom of the screen. If you choose not to click “Save,” 
a warning message will appear on each step thereafter, until 
you click on the “Save” button and select the folder within My 
Content to which you would like to save your assignment.

NOTE:	 Make sure to allow pop-ups from unitedstreaming when saving an 
assignment to My Content, or hold down the “Control” key when clicking 
the “Save” button to temporarily allow the pop-up window to open.

Step 2: Add Materials

You can add media to your assignment, such as video segments, 
animations or audio files. You can also add an activity such as 
a Quiz or Writing Prompt or add links to websites.

Step 3: Material Instructions

Once you have selected media, activities and websites for your 
assignment, you can write step-by-step instructions that your 
students will see as they work with each material type.

Step 4: Preview

The Preview feature allows you to see what your assignment 
looks like in its final form. If you wish to make changes simply 
click on any of the steps in the process chain.

Step 5: Summary

The summary provides assignment information you will share 
with your students. When you provide the Assignment Code, 
students will need to:

1.	Go to www5.unitedstreaming.com/studentcenter 

2.	Enter the assignment code, and their first and last name in 
the fields provided. 

When you provide the Student Center Link, students are taken 
directly to unitedstreaming’s Student Center. The Assignment 
Code will be pre-populated and students simply enter their 
first and last name in the field provided.

Assignment Builder
The Assignment Builder is a versatile 
resource that helps you build online activities 
and web-based projects that are stored on 
the Discovery Education unitedstreaming 
servers. You can use this tool to create student 
assignments that integrate a variety of digital 
media types. Students access assignments 
through the Student Center.

Creating a New Assignment

Access the Assignment Builder from anywhere on the site by clicking on Teacher Center in the navigation bar at the top of the screen. 
To get started, click on “Create New” from the Assignment Builder home page and follow these easy steps:

Discovery Education unitedstreaming

Teacher center

http://www.unitedstreaming.com
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Step 1: General Information

Start by providing information about your quiz in the form 
provided. The quiz name, author, school, subject area, and 
grade level are required fields. You can also create quiz 
instructions, learning objectives and teacher notes.

You can save your quiz by clicking on the “Save” button at 
the bottom of the screen. If you choose not to click “Save,” a 
warning message will appear on each step thereafter, until 
you click on the “Save” button and select the folder within My 
Content to which you would like to save your quiz.

NOTE:	 Make sure to allow pop-ups from unitedstreaming when saving a quiz 
to My Content, or hold down the “Control” key when clicking the “Save” 
button to temporarily allow the pop-up window to open.

Step 2: Add Materials

You can use the Keyword Search to add full videos and video 
segments to your quiz or search for video content by Subject 
and Grade.

Step 3: Add Questions

The Question Databank contains thousands of questions you 
can add to your quiz, or you can write your own questions.

Step 4: Preview

The Preview feature allows you to see what your quiz looks like 
in its final form. If you wish to make changes simply click on 
any of the steps in the process chain.

Step 5: Summary

The summary provides quiz information you will share with 
your students. When you provide the Quiz Code, students will 
need to:

1.	Go to www5.unitedstreaming.com/studentcenter

2.	Enter the Quiz code, and their first and last name in the 
fields provided. 

When you provide the Student Center Link, students are taken 
directly to unitedstreaming’s Student Center. The Quiz Code 
will be pre-populated and students simply enter their first and 
last name in the field provided.

Quiz Builder
The Quiz Builder tool allows you to create 
online assessments that you can use to test 
student comprehension or survey prior 
knowledge. You can search over 2,000 pre-made 
quizzes in the Quiz Library, choose individual 
questions from the Quiz Builder databank or 
write your own questions. Students access 
quizzes through the Student Center.

Creating a New Quiz

Access the Quiz Builder from anywhere on the site by clicking on Teacher Center in the navigation bar at the top of the screen. To get 
started, click on “Create New” from the Quiz Builder home page and follow these easy steps:

Discovery Education unitedstreaming

Teacher center

Integration Idea:  
Prepare students for an upcoming test by creating review questions using Quiz Builder.
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Writing Prompt Builder
Stimulate the writing process in your 
classroom with thousands of images that 
are ready-made for declarative, persuasive, 
narrative, and expository writing exercises. 
You can search the Writing Prompt Library 
for images accompanied by suggested text or 
create your own writing prompts with the help 
of the Writing Prompt Builder.

Creating a New Writing Prompt

Access the Writing Prompt Builder from anywhere on the site by clicking on the Teacher Center link in the navigation bar at the top of 
the screen. To get started, click on “Create New” from the Writing Prompt Builder home page and follow these easy steps:

Step 1: General Information

Start by providing information about your writing prompt 
in the form provided. The writing prompt title, author and 
school are required fields. You can also select a subject area, 
grade level(s) and choose from four different types of writing 
exercises: declarative, persuasive, narrative, or expository. 
These fields are not required, but they are useful if you decide 
to share your writing prompt with others.

You can save your writing prompt by clicking on the “Save” 
button at the bottom of the screen. If you choose not to click 
“Save,” a warning message will appear on each step thereafter, 
until you click on the “Save” button and select the folder within 
My Content to which you would like to save your writing prompt.

NOTE:	 Make sure to allow pop-ups from unitedstreaming when saving a writing 
prompt to My Content, or hold down the “Control” key when clicking the 
“Save” button to temporarily allow the pop-up window to open.

Step 2: Select Image

You can search from over 20,000 high quality, photographic 
images by typing a word or phrase in the Keyword Search or 
by selecting a subject from the drop down menu. Preview an 
image by clicking on the thumbnail. When you find an image 
that you like, click on the link “Add to my Writing Prompt.”  
Next, select the page orientation and border and then click 
the “Continue” button.

Step 3: Customize Text

Writing Prompt Builder allows you to select the font type, style, 
size and color for the title and the caption. You can preview 
your selections by clicking the “Preview” button. Once you’ve 
formatted your title and caption, click the “Continue” button.

Step 4: Preview

The Preview feature allows you to see what your writing 
prompt looks like in its final form. If you wish to make changes 
simply click on any of the steps in the process chain.

Step 5: Summary

The summary provides writing prompt information you will 
share with your students. When you provide the Writing 
Prompt Code, students will need to:

1.	Go to www5.unitedstreaming.com/studentcenter 

2.	Enter the Writing Prompt Code, and their first and last name 
in the fields provided. 

When you provide the Student Center Link, students are taken 
directly to unitedstreaming’s Student Center. The Writing 
Prompt Code will be pre-populated and students simply enter 
their first and last name in the field provided.

Discovery Education unitedstreaming

Teacher center

http://www.unitedstreaming.com
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Calendar
Make history come alive every day by showing video content to your students that presents events 
that occurred on a particular calendar day, week or month in history.

Access the Calendar from anywhere on the site by clicking on 
the Teacher Center link in the navigation bar at the top of the 
screen. The Calendar tool is a great way to locate videos that 
are associated with important events in history, prominent 
people, commemorative events and cultural celebrations.

Calendar events are categorized by subject area including: 
Science, Mathematics, Social Studies, Arts & Humanities, 
Language Arts, Biography and Health & Guidance. You can 
customize your display by viewing all events for a specific 
day or choose to view events for an entire week or month, by 
subject. Click on an event title to view a full event description 
and a list of unitedstreaming resources which may include full 
videos, video segments, articles and images.

Discovery Education unitedstreaming

Teacher center

Integration Idea:  
Locate historic events or fun facts that occurred on students’ birthdays using the Calendar tool.
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Access the Lesson Plan Library from anywhere on the site 
by clicking on the Teacher Center link in the navigation bar at 
the top of the screen. Click on a subject area to view lesson 
plans that contain descriptions and indications regarding the 
recommended grade ranges.

Lesson plans can be viewed or saved in PDF or Microsoft Word 
format. To save a lesson plan, click on the appropriate format 
and select “Save.” Navigate to the desired location. You can 
change the name of the lesson, but keep the “.pdf” or “.doc” 
file extension.

Lesson Plan Library
The Lesson Plan Library has a new search interface and contains more than 200 lessons designed for 
use with Discovery Education unitedstreaming videos.

Discovery Education unitedstreaming

Teacher center

http://www.unitedstreaming.com
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Thematic Focus
Each Thematic Focus provides links to lessons and materials organized around a central theme or 
topic. New themes are added weekly and many focus on seasonal or timely events.

Access Thematic Focus from anywhere on the site by 
clicking on Teacher Center in the navigation bar at the top  
of the screen. Next, click on Thematic Focus. In each 
Thematic Focus, you will find a wealth of topic-specific 
information including:

•	Resources 
A discussion guide and lesson plans organized by grade levels

•	Media 
A list of downloadable video segments

•	Activities 
Problems, puzzles and worksheets

•	Events & Articles  
Written material that support the theme

Click the “Thematic Focus Archive” link to view a complete list 
of thematic units organized by subject.

Discovery Education unitedstreaming

Teacher center

Integration Idea:  
Search unitedstreaming’s vast image library for primary source materials to use in your instruction.
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Professional Development
Discovery Education offers a host of staff development options designed to help you make the most 
effective use of Discovery Education unitedstreaming digital resources. Among the options are self-
paced tutorials, online sessions, and professional development materials.

Discovery Education unitedstreaming

PROFESSIONAL DEVELOPMENT

NOTES:

http://www.unitedstreaming.com
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Professional Development 

Teaching Tips

Preview quick, 30-second technology tips—from editing  
unitedstreaming videos to creating hyperlinks—and learn how 
to infuse your lessons with technology.

Trainer’s Toolkit

Use the resources and materials in the Trainer’s Toolkit to 
enhance your unitedstreaming staff development workshops. 
Download digital versions of the User Guide, the QuickStart 
Guide and other support documents.

Discovery Educator Network

Learn how to become a member of a dynamic community 
of teachers—the Discovery Educator Network—and have 
access to a library of Educator Resources, discussions boards, 
and a variety of training materials. Members also have the 
opportunity to attend regional and national events sponsored 
by Discovery Education and the Discovery Educator Network.

www.discoveryeducatornetwork.com

Tech Talk

Visit Tech Talk to locate resources from the unitedstreaming 
Implementation and Support Team. You will find materials to help 
you successfully launch unitedstreaming at your school or district 
and documents that address technical and network issues.

Best Practices

View short, 30-second video segments that address timely 
educational themes and gain exciting strategies for 
differentiating instruction, integrating technology in the 
classroom, and communicating with parents. Learn more and 
watch the video in its entirety by clicking on the link that will 
take you to the full video.

Interactive Training

You can learn online at your own pace with this engaging 
series of lessons. Begin with Lesson 1 and learn how to 
search, play and download unitedstreaming video segments. 
Additional lessons demonstrate digital media integration, 
differentiated instruction techniques, and professional 
development training strategies. Print a certificate after the 
successful completion of each lesson and explore professional 
development credit options with your staff development 
coordinator or administrator.

Project Demonstrations

Project Demonstrations provide exemplary lesson plans, 
multimedia projects, and tutorials that support the successful 
integration of unitedstreaming content with popular software 
applications. Leverage the software in your classroom and 
learn how to edit unitedstreaming video, embed and hyperlink 
video and images in graphic organizing software or present 
unitedstreaming content using interactive whiteboards.

Courses for Credit

Discovery Education is collaborating with several accredited 
universities to offer dynamic, online graduate courses that 
focus on integrating unitedstreaming digital media in the 
classroom. Courses can be taken individually or applied to a 
certificate or master’s degree program. 

Webinars

A webinar is an online seminar with interactive training 
elements. Collaborate in live, hour-long sessions with a 
Discovery Education instructor using WebEx and your phone. 
Register for a variety of topics and times each week—all 
free with your unitedstreaming license. Topics range from 
integrating video and images in PowerPoint to using 
unitedstreaming content to create WebQuests and  
digital stories.

Discovery Education unitedstreaming

Professional development & …

NOTES:

Integration Idea:  
Kick off a staff development workshop with a teaching tip that describes how to embed a video in PowerPoint.

http://www.discoveryeducatornetwork.com


Discovery Education O ne Discovery Place, Silver Spring, MD 20910  www.unitedstreaming.com   1-800-323-9084

23

Need assistance?  Contact your Account Representative today at 1-800-323-9084.

Steps to a Successful unitedstreaming Launch

Step 1:	 Schedule a unitedstreaming orientation for your 
teachers and other key contacts. 

Step 2:	Write your school’s eight-character passcode on 
your school kit materials, including posters and 
passcode flyers.

Step 3:	 One week before your workshop, place invitations in 
your colleagues’ mailboxes.

Step 4:	 Two days before the scheduled session, distribute 
the passcode flyer and encourage colleagues to 
create a unitedstreaming account in advance.

Step 5:	 On the day of the workshop, distribute unitedstreaming 
resource materials (found in your school kit or online 
in Professional Development > Tech Talk).

Please contact your Account Representative between  
8 a.m. and 5 p.m. Central Standard Time at 1-800-323-9084 for 
more information.

Additional Professional Development Resources

Coordinate follow-up sessions and encourage educators 
to take advantage of these exciting resources, found in the 
Professional Development section of unitedstreaming:

•	Webinars 
A webinar is an online seminar with interactive training 
elements. Collaborate in live, hour-long sessions with a 
Discovery Education instructor using WebEx and your phone. 
Register for a variety of topics and times each week.

•	Interactive Training 
Learn online at your own pace with this engaging series 
of lessons that demonstrate digital media integration, 
differentiated instruction techniques, and professional 
development training strategies. Successful completion 
of each lesson yields a certificate and professional 
development credit options.

•	Courses for Credit 
Discovery Education is collaborating with several accredited 
universities to offer dynamic, online graduate courses that 
focus on integrating unitedstreaming digital media in the 
classroom. Courses can be taken individually or applied to a 
certificate or master’s degree program.

Implementation Support
Tens of thousands of schools have discovered how easy it is to launch Discovery Education 
unitedstreaming, and you can too. Our Implementation Team is ready and waiting to help you maximize 
the value of our rich media library for your educators. Your dedicated Account Representative will 
help you plan and complete a successful rollout of unitedstreaming in your school(s).

Discovery Education unitedstreaming

Implementation support

NOTES:
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The procedure involved in creating hyperlinks will vary with 
certain software applications. The following steps apply to 
documents created in Microsoft Word and PowerPoint:

1.	Download a video segment to a designated folder.

2.	Save your new or revised Word or PowerPoint document in 
the same folder.

3.	Highlight the text or select the image on the page that you 
wish to use for the hyperlink.

4.	Go to “Insert” > “Hyperlink.”

5.	Click to select the video file that you wish to link to the text 
or image in your document. 

Note:	 With some software versions, you may have to “Browse for File” and 
navigate to your saved file.

6.	Click “OK” when finished.

To test your hyperlink, move your cursor over the link. It should 
change from an arrow to a pointing finger. In PowerPoint, you 
will need to be in the “Slide Show” view to test your link.

Creating a Hyperlink to a Video Segment
What is a hyperlink? 

A hyperlink is a text or graphic element that points to a specified web page or opens a digital file 
that has been saved on a local computer or network server. After you have downloaded and saved 
Discovery Education unitedstreaming video segments, you can create hyperlinks using text and 
images. Users simply click the text or image hyperlink to open and play a video segment. Hyperlinking 
is a simple way for teachers and students to play video files within a separate media player window 
that provides access to player controls such as volume, play, pause, and stop.

Create a Hyperlink to a Video

Discovery Education unitedstreaming

Professional development & …

Integration Idea:  
Create a clickable map in PowerPoint that contains hyperlinks to relevant video segments.
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The procedure involved in embedding video files will vary with 
certain software applications. The following steps apply to 
documents created in Microsoft PowerPoint:

1.	Download a video segment to a designated folder.

2.	Save your new or revised PowerPoint document in the 
same folder.

3.	Go to “Insert” > “Movies and Sounds” > “Movie from File.”

4.	Click to select the video file that you wish to insert in your 
document. 

Note:	 With some software versions, you may have to “Browse for File” and 
navigate to your saved file.

5.	Select the automatic play option or choose to start the video 
with a mouse click.

TIP:	 PC users will need to download Windows Media (.asf) 
files and Macintosh users will need to download 
QuickTime (.mov) files.

TIP:	 Keep the folder and file names brief. If the full path to a 
media file exceeds 128 characters, the file will not load 
and the viewer will see a blank white space where the 
embedded video file was intended.

Embedding a Video Segment
What is embedding? 

When you embed a downloaded file, you insert it right into your document much as you would 
a picture or clip art file. Embedding makes use of the multimedia capabilities in software such 
as PowerPoint, AppleWorks, and Keynote and allows teachers to create presentations that do not 
rely on separate media players. Embedding is an effective way to add video content to existing 
presentations, create interactive learning projects with menus and text prompts, or develop slide 
shows in which video files play automatically.

Embed a Video in PowerPoint

Discovery Education unitedstreaming

Implementation support
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Using a PC
Play a Closed Captioned Video Segment  
in the Embedded Player

1.	Check the “Enable Closed Captioning” box, located in the 
Media Settings box below the player window.

2.	Click on “Play” next to the video segment you wish to view.

Play a Closed Captioned Video Segment  
in Full Screen View

Closed Captioning is not always available when viewing videos 
in Full Screen mode using the Embedded Player. To correct 
this, try selecting “Stand-Alone Application” as a Player 
Selection and making the video player window larger.

Download a Closed Captioned Video Segment

1.	Check the “Enable Closed Captioning” box, located in the 
Media Settings box below the player window.

2.	Save the video segment. Right-click on the Download icon 
next to the desired segment and select “Save Target As.” 
Navigate to the desired location and save the video file. 
Make sure the file ends with the .asf extension.

3.	Download the Closed Captioned Transcript. Right-click on 
the CC icon for the segment you are downloading and select

“Save Target As.” Navigate to the exact location where you
saved the video segment and save the transcript file. Make 
sure the file ends with the .smi extension.

Play a Downloaded, Closed Captioned Video Segment 
Using Windows Media Player

1.	Locate your saved video file (.asf) and double-click to open it 
in Windows Media Player.

2.	Click on the “Play” menu and select “Captions and 
Subtitles.” Select “On if Available.”

3.	Click on the Play button to play the video.

4.	Windows Media Player 10 only: Click on the “Tools” menu. 
Select “Options,” then select the “Security” tab. Check the 
box next to “Show local captions when present.” Click “OK.”

Using a Mac
Play a Closed Captioned Video Segment on a Mac:

1.	Check the “Enable Closed Captioning” box, located in the 
Media Settings box below the player window.

2.	Select “Windows Media” for the Media Type Selection.

3.	Select “Stand-Alone Application” for the  
Player Selection.

4.	Click the Play icon next to the segment you wish to view. 
Windows Media Player will open a new window.

5.	In Windows Media Player, select the “View” menu and select 
“Show Captions.”

Closed Captioning
When you enable Discovery Education unitedstreaming’s Closed Captioning, the video player will 
display the audio portion of the video as text right below the video image. With Closed Captioning, you 
can address the different learning needs of students and enhance comprehension as students read, 
listen, and view video content.

Discovery Education unitedstreaming

professional development & …

Integration Idea:  
Support English language learners by incorporating Closed Captioned video segments into your lessons.
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Storage Considerations

It is recommended that users play/stream videos to preview 
content and save/download videos to use in the classroom. 
Downloading insures a smooth and uninterrupted playing 
experience that will not be diminished by bandwidth or 
connectivity issues. It is a good idea to determine in advance 
the best place for unitedstreaming users to save their 
downloaded video segments.

Video files are formatted to 256 k to ensure quality video while 
maintaining small files sizes and download efficiency. One 
minute of video requires 1.8 mb of storage space on digital 
media. This means that just one minute of video would contain 
too much data for a floppy disk.

Storage Suggestions

•	Desktop Storage 
Create a folder on your desktop to house downloaded segments.

•	Public Shared Folder(s) 
Eliminate duplicate video segments by downloading files to 
a shared location such as a local network server. Multiple 
teachers may access downloaded clips at one time. 
Technology Coordinators might choose to set up a folder 
structure when video segments are to be stored at a shared 
location so that users can save files according to subject 
areas or grade level.

unitedstreaming Services

•	Network Manager 
Schedules downloads at off-peak times.

•	Blocktime Editor 
Schedules times to restrict streaming and downloading.

•	Local Hosting	
Content shipped via firewall hard-drive; hosted on your server.

•	Upload Manager 
Upload your school’s content to unitedstreaming for your 
users only.

unitedstreaming & Third Party Software

You must have the latest versions of these programs to 
effectively use unitedstreaming:

•	Windows Media Player (PC) or QuickTime (Mac)

•	Macromedia Flash Plug-In

•	Adobe Reader

Please visit the Help section of unitedstreaming to download 
the latest versions of these programs.

Displaying unitedstreaming Content

The following methods are recommended for presenting 
unitedstreaming content in the classroom:

•	Use a Scan Converter connected to a large screen television 
to change computer-video signals to NTSC or PAL format. 
Extron and Averkeys are two popular brands.

•	Connect an LCD projector to a classroom computer to create 
a presentation station.

•	Download video segments, images, clip art, and animations 
to create activities for students to complete at computer 
stations or learning centers.

Other Important Technology Considerations:

•	When playing or streaming a video online, one video can be 
simultaneously accessed by many end-users.

•	If you are on a T-1 connection, six people (at 256 k) can stream 
simultaneously with no buffering, assuming there is no other 
Internet traffic on the network.

•	Screen resolution should be set to a minimum of 800 x 600 dpi; 
recommended resolution is 1024 x 768 dpi.

Storage and Technology Information
Discovery Education is eager to help you make this valuable resource successful in your schools. 
Consider the following as you introduce Discovery Education unitedstreaming in your school.

Discovery Education unitedstreaming

implementation support
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A Report on the Effect of Discovery Education unitedstreaming
Through rigorous, independent scientific evaluation, Discovery Education unitedstreaming is the 
only educational digital video-based learning resource that has been shown to increase student 
achievement. Two random-assignment, control group studies—conducted in rural Virginia in 2002 and 
urban Los Angeles, California in 2004—showed significant improvement in Social Studies, Science, 
and Math performance for students exposed to video content from unitedstreaming over those 
students not exposed to the content.

These evaluations have caught the attention of policymakers across the nation. Discovery Education executives have been invited to 
present the results to the United States House of Representatives’ Committee on Education and the Workforce, at United States 
Department of Education Technology Summits, and at various state and national education technology conferences around the country.

•	12.6% average increase in 
achievement in Social Studies and 
Science scores over control group

•	3–5% average increase in 
achievement in Mathematics 
scores over control group

Discovery Education unitedstreaming

professional development & …

Integration Idea:  
Play an audio clip and have students draw or write a description of the sound.
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Discovery Educator Network
The Discovery Educator Network is a global community of educators who are excited by the power of 
digital media and want to collaborate and share resources with other teachers.

Discovery Education invites dynamic teachers incorporating digital media in their classroom 
curriculum to join the Discovery Educator Network. Educators selected will benefit through access 
to a wide range of resources, professional development activities, networking opportunities and 
exclusive Discovery Educator events. Committed to sharing ideas and resources with educators in 
their local community, Discovery Educators will be supported in providing local demonstrations and 
presentations at both the state and national levels.

•	Participate in an active online forum and ideas exchange at 
www.discoveryeducatornetwork.com

•	Connect with people who have similar educational 
technology interests.

•	Download resources and professional development 
support materials.

•	Use the power of Discovery Education to make your creative 
classroom ideas a reality.

•	Participate in exclusive Discovery Education events  
and sweepstakes

•	Serve as beta testers for future Discovery Education products 
and sites.

www.discoveryeducatornetwork.com
NOTES:

Discovery Education unitedstreaming
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Discovery Education unitedstreaming

GLOSSARY OF TERMS

Bandwidth

The amount of information or data (text, images, video, sound) 
that can be sent over a communication channel, such as a 
network, in a given period of time. The higher the bandwidth, 
the more information the channel can carry. It is similar to 
roadways—a four-lane highway can carry more traffic than a 
two-lane highway.

Blackline Masters

Supplementary materials in the form of worksheets and other 
tools associated with unitedstreaming video programs. They 
are in PDF format so that they can be easily downloaded and 
printed to hand out to students. You will need Adobe Acrobat 
Reader installed on your computer to be able to open these files.

Buffer

A temporary storage location for data information being sent 
or received. It compensates for differences between two 
different devices in ability or speed in data handling. The buffer 
functions like a reservoir, capturing the data and then letting 
it out at speeds the lower-capacity device can accommodate. 
The verb buffer refers to the act of collecting and storing the 
data until it can be used.

Download

To transfer or save a file from a computer or server to your own 
computer via the Internet. Things you might download include 
video and image files. After an image or video is downloaded, 
you may view the file on your own computer without being 
connected to the Internet.

Embedded Video

When you embed a downloaded file, you insert it right into 
your document. Embedding makes use of the multimedia 
capabilities in software such as PowerPoint, AppleWorks, and 
Keynote and allows teachers to create presentations that do 
not rely on separate media players. Embedding is an effective 
way to add video content to existing presentations, create 
interactive learning projects with menus and text prompts, or 
develop slide shows in which video files play automatically.

Hyperlink

A hyperlink is a text or graphic element that points to a 
specified web page or opens a digital file that has been 
saved on a local computer or network server. After you have 
downloaded and saved unitedstreaming video segments, 
you can create hyperlinks using text and images. Users 
simply click the text or image hyperlink to open and play a 
video segment. Hyperlinking is a simple way for teachers and 
students to play video files within a separate media player 
window that provides access to player controls such as 
volume, play, pause, and stop.

PDF file

Portable Document Format. This format was developed 
by Adobe to allow files to retain their original formatting 
regardless of whether the end user has the program with 
which the file was created. The documents will have the 
extension “PDF.” You must have Adobe Acrobat Reader (a free 
download from the Adobe website) installed on your computer 
to be able to open the files.

Stream

Any data transmission that occurs in a continuous flow. 
Streaming audio and video files allow you to display or play 
the beginning before all the data has been transferred. A 
unitedstreaming video file can be streamed and played in 
Windows Media Player (PC) or QuickTime player (Mac). You can 
begin viewing the file with little delay as opposed to waiting for 
the entire file to download.

Teacher’s Guide

A supplementary guide is available for most unitedstreaming 
video programs. Teacher’s Guides contain program objectives, 
discussion questions, and lesson plans that support 
unitedstreaming video content. The PDF format ensures 
easy downloading.

Webinar

An online seminar with interactive training elements. 
Discovery Education offers hour-long sessions using the 
platform WebEx and a phone. A variety of topics and times are 
available each week—all free with your unitedstreaming license.

Modification & Distribution Rights
As a unitedstreaming subscriber, you have Discovery 
Education’s permission to modify and distribute this manual. 
Kindly include reference and citation information when you 
modify the contents. You do not have permission to profit from 
the redistribution of this manual or any other materials from 
Discovery Education.

Integration Ideas: Find even more ideas online at www.unitedstreaming.com. 
Activate students’ thinking at the beginning of a lesson by showing a short video segment.

http://www.unitedstreaming.com
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